ORACLE Job Aid

USER PRODUCTIVITY KIT

Create Draft response and retrieve

/= FIN UAT =

& PWCMobius poF @

Good morning, Brian Grover!

Supplier Portal

ortal
Supplier Portal

Things to Finish

3 minutes ago Yesterday Vesterday

Assigned 1o Me ACTION REQUIRED

You Are Invited to

hitps://epvd-devl.fa.us2 oraclecloud.com/fsemUl/fac 88 a _aftM _afMFM=08_ _afMFG=08, 08_afiMFO=0%

Step Action

1. Click on the Supplier Portal link.

plier Porta

Date Created: 6/24/2021 5:54:00 PM
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Job Aid

ORACLE

USER PRODUCTIVITY KIT

Supplier Portal

Shipments 2

» Manage Shipments
» Create ASN

» Create ASBN

» Upload ASN or ASBN

2
» View Receipts
« View Returns M Negoliations Closing Soon
Contracts and Deliverables
» Manage Contracts Recent Activity g
« Manage Deliverables Last30 Days
H MNegotiation invitations 1
Consigned Inventory
* Review Consumption Advices Orders changed or canceled 3
= Review Consigned Inventory Orders opened 3
» Review Consigned Inventory Transactions 2
Invoices and Payments
Transaction Reports
» Create Invoice Last 30 Days
» Create Invoice Without PO PO Purchase Amount a0 usD
» View Invoices
» View Payments
Solicitations
»
= View Active Solicitations .
» Manage Responses
Supplier News
Qualifications
< >

» Manage Questionnaires

-devl fa.us2.oraclecloud.com/fscmUl/faces/FuseWelcome?_afrLoop L_afiM _aftMFM=08._afMFR=068. afrM _afMFS=08_afrMFO=02

Step

Action

Click on the Negotiation invitations link.

Megotiation invitations

& PWCMobius I

Request for Qualification: 70043-21 | essages | create Response | actions v |

Currency = US Dollar Time Zone Eastern Standard Time
Title Bridge Repair Open Date 6M17/21 1:33 AM
Status  Active (Locked) Close Date  6/24/21 1:18 AM

Time Remaining 6 Days 23 Hours

=
Table of Contents Cover Page
Cover Page
oo REQUEST FOR
Contract Terms QUALIFICATION
Bridge
Repair

E| PUBLISHED DATE:6/17/21 1:33 AM
DUE DATE:6/24/21 1:18 AM
TIME ZONE: EASTERN TIME

epvd-devl.fa.us2.oracleclouc fscmUl/faces/FuseWelcome?

Page 2
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ORACLE

USER PRODUCTIVITY KIT

Job Aid

Step Action
3. Click on the Actions button.
G PWCMODIUS CRE T
Request for Qualification: 70043-21 [ essages | creats Response | actions + Jf oone |
Respond >
Gurrency = US Dollar Time Zor [lime
Analyze >
Title Bridge Repair Open Date  8/17/21 1:33 Al
Status  Active (Locked) Close Date  6/24/21 MEA!" View .‘
Time Remaining 6 Days 23 Hours
=
Table of Contents Cover Page
Cover Page
‘L’"’ REQUEST FOR
ines
Contract Terms QUALIFICATION
Bridge
Repair
E| PUBLISHED DATE:6/17/21 1:33 AM
DUE DATE:6/24/21 1:18 AM
TIME ZONE: EASTERN TIME
Step Action
4.

Wiew

Click on the View list option.

Date Created: 6/24/2021 5:54:00 PM
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Job Aid ORACLE’
USER PRODUCTIVITY KIT

& PWCMobius ® v ® .

Request for Qualification: 70043-21 [ essages | creats Response | actions + Jf oone |

Respond >
Currency = US Dollar Time Zor [fime
Analyze >
Title Bridge Repair Onen Date  AM7191 1 Al

View PDF ‘ View "‘

Status  Active (Locked)

View Attachments
Time Remaining 6 Days 23 Hours

=
Table of Contents Cover Page
Cover Page
oo REQUEST FOR
Contract Terms QUALIFICATION
Bridge
Repair

E| PUBLISHED DATE:6/17/21 1:33 AM
DUE DATE:6/24/21 1:18 AM
TIME ZONE: EASTERN TIME

Step Action

5. Click the View PDF list option to download and review the solicitation.
YWiew PDF

& PWCMobius A

Request for Qualification: 70043-21 | messages | create Response | actions |

Currency = US Dollar Time Zone Eastern Standard Time
Title Bridge Repair Open Date 6M17/21 1:33 AM
Status  Active (Locked) Close Date  6/24/21 1:18 AM
Time Remaining 60§ gpening 70043-21_SUPPLIER. pdf X
You have chosen to open: ==
Table of Contents
Cover Pa [E3 70043-21_SUPPLIER.pdf
Cover Page which is: Portable Document Format (PDF)
Overview from: hitps://epvd-dev1.fa.us2.craclecloud.com
Lings
What should Firefox do with this file?
Contract Terms
O Open with Firefox
(O Open with | Microsoft Edge (default) v
(®) Save File

[ Do this automatically for files like this from now on.

{ pUBLISE
DUE DAT Cancel
TIME Z!

Page 4 Date Created: 6/24/2021 5:54:00 PM




ORACLE
USER PRODUCTIVITY KIT

Job Aid

Step Action

6. Click on the OK button.
0K

& PWCMoDbius

Request for Qualification: 70043-21

Currency = US Dollar
Title  Bridoe Repair

Status  Active (Locked)

Time Remaining & Days 23 Hours

Table of Contents Cover Page
Cover Page

Overview

Lines

Contract Terms

https://epvd-devl fa.us2 oraclecloud.com/fscmUl/faces/FuseWelcome?_afrLoop=3463..H.

Time Zone Eastern Standard Time
Open Date  6M7/21 1:32AM

Close Date  6/24/21 1:18 AM

REQUEST FOR
QUALIFICATION

Bridge
Repair

H PUBLISHED DATE:6/17/21 1:33 AM
DUE DATE:6/24/21 1:18 AM
TIME ZONE: EASTERN TIME

88 afrMFC=88_afrMFCl=08_afrMFM=08_afrMFR=968&_afrMFG=08_afrMF5=0&_afrMFO=0#

Step Action

7. Click on the Actions button.

Date Created: 6/24/2021 5:54:00 PM
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Job Aid

ORACLE
USER PRODUCTIVITY KIT

& PWCMobius

Request for Qualification: 70043-21

Currency = US Dollar
Title Bridge Repair

Status  Active (Locked)

Time Remaining 6 Days 23 Hours

Table of Contents Cover Page
Cover Page

Overview

Lines

Contract Terms

Respond >

Time Zor [fime
Analyze >
Open Date  6M17/21 1:33 Al
‘ View b‘
Close Date  6/24/21 1:18 Al
=]

REQUEST FOR
QUALIFICATION

Bridge
Repair

E| PUBLISHED DATE:6/17/21 1:33 AM

DUE DATE:6/24/21 1:18 AM

TIME ZONE: EASTERN TIME

Step

Action

Click on the View list option.

Wiew

& PWCNoDbius

Request for Qualification: 70043-21

Currency = US Dollar
Title Bridge Repair

Status  Active (Locked)

Time Remaining & Days 23 Hours

Table of Contents Cover Page
Cover Page

Overview

Lines

Contract Terms

Respond »

Time Zon ime
Analyze »
Onen Nate  AM7191 4°33 4
View PDF ‘ View "
View Attachments
=]

REQUEST FOR
QUALIFICATION

Bridge
Repair

EI PUBLISHED DATE:6/17/21 1:33 AM

DUE DATE:6/24/21 1:18 AM

TIME ZONE: EASTERN TIME

Page 6
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ORACLE Job Aid
USER PRODUCTIVITY KIT

Step Action

9. Click on the View Attachments list option

Wiew Attachments

& PWCMobius n v ® .

Attachments (Request for Qualification 70043-21) [ oone |
Search ‘ File Name or URL X " 0‘| Show Filters
Actions w View v Format w F 5] Download
File Name or URL Level Attached To Title Size
Laptops.td Header Laptops.txt 3KB

Columns Hidden 3

https://epvd-devl fa.us2.oraclecloud.com/fscmUl/faces/FuseWelcome?_afrLoop=3463..H=7688 _afrMFC=88_afrMFC|=08_afrMFM=08t_afrMFR=968_afrMFG=08_afrMF5=08&_afrMFO=0&

Step Action

10. Select the Attachment row.

Date Created: 6/24/2021 5:54:00 PM Page 7




Job Aid ORACLE’
USER PRODUCTIVITY KIT

& PWCMobius A

Attachments (Request for Qualification 70043-21) Done

Search ‘ File Mame or URL X " Q| Show Filters

Actions w View v Formatw 7

[oowmcne |
File Name or URL Level Attached To Title Size

Laptops.td Header Laptops.tx 3KB

Rows Selected 1 Columns Hidden 3

wvd-devl.fa.us2 oraclecloud.com/fscmUl/faces/Fu: ome?_afrLoop: E frMFC: afrMFCI=08,_afrMFM=0 frivi frV frivi _afrtMFO=0%

Step Action

11. Click the Download button.

Download
& PWCNMoDius & v ® .
Attachments (Request for Qualification 70043-21) Ea

Search ‘ File Name or URL % || 9, | show Fitters
Actions w View v Formatw 7 =)
File Name or URL Level Attached To Title Size
Opening Negotiation70043-21-Attachments.zip x

Laptops.bd Header Laptops.bxt 3KB

You have chosen to open:
¥ Negotiation70043-21-Attachments.zip

which is: Compressed (zipped) Folder (948 bytes)
from: https://epvd-dev! fa.us2.oraclecloud.com

Rows Selected 1 Columns Hidden 3

What should Firefox do with this file?
@ Qpen with! | Windows Explorer (default) v
O Save File

- e

Page 8 Date Created: 6/24/2021 5:54:00 PM




ORACLE

USER PRODUCTIVITY KIT

Job Aid

Step

Action

12.

Open the Attachement to download and view.

O Windows Explorer (default) w
& PWCMobius @ v ® w.
Attachments (Request for Qualification 70043-21) [ oone |
Search ‘ File Name or URL X " 0\| Show Filters
Actions w View v Formatw =)
File Name or URL Level Attached To Title Size
Opening Negotiation70043-21-Attachments.zip X
Laptops.td Header Laptops.txt 3KB
You have chosen to open:
Rows Selected 1 Columns Hidden 3
¢ 21-Attach
which is: Compressed (zipped) Folder (943 bytes)
from: https://epvd-dev1 fa.us2.oraclecloud.com
What should Firefox do with this file?
(O Open with | Windows Explorer (defautt) -
(@) Save File

Step

Action

13.

Click the OK button.
0K

Date Created: 6/24/2021 5:54:00 PM
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Job Aid ORACLE’
USER PRODUCTIVITY KIT

& PWCMobius A

Attachments (Request for Qualification 70043-21) Done

Search ‘ File Mame or URL X " Q| Show Filters

Actions w View v Formatw 7

File Name or URL Level Attached To Title Size

Laptops.td Header Laptops.txt 3KB

Rows Selected 1 Columns Hidden 3

vd-dev.fa.us2.oraclecloud.com/fscmUl/faces/FuseWelcome?_afrLoop= frMFC: frVIFC| 9 frMFG=08L_afrM _afrMFO=0%

Step Action

14. Click the Done button.

_U-FWCMObIUS [ @ BG

Request for Qualification: 70043-21 | essages | create Response | actions v |

Currency = US Dollar Time Zone Eastern Standard Time
Title Bridge Repair Open Date 6M17/21 1:33 AM
Status  Active (Locked) Close Date  6/24/21 1:18 AM

Time Remaining 6 Days 23 Hours

=
Table of Contents Cover Page
Cover Page
oo REQUEST FOR
Contract Terms QUALIFICATION
Bridge
Repair

E| PUBLISHED DATE:6/17/21 1:33 AM
DUE DATE:6/24/21 1:18 AM
TIME ZONE: EASTERN TIME

https://epvd-dev fa.us2. oraclecloud.com/fscmUl/faces/FuseWelcome?_afrLoop= L |=08_afrMFM=08_afrMFR=968_afrMFG=08_afrMF afMFO=0%

Page 10 Date Created: 6/24/2021 5:54:00 PM




ORACLE’ Job Aid
USER PRODUCTIVITY KIT

Step Action

15. Click in the Create Response button.

& PWCMobius m v ® .

| JONO)

Overvie Lines Review

Create Responso (Rosponso 4010: o ETARTE e - Y N I

Last Saved 6/17/21 1:41 AM
Time Zone Eastern Standard Time

Title  Bridge Repair Close Date  6/24/21 1:18 AM

Time Remaining 6 Days 23 Hours

General
Supplier A& M Concrete Corporation Response Type (@) Primary

Supplier Site  STERLING-42685 Alternate

Solicitation Currency USD

Response Currency USD

Price Precision 2 Decimals Maximum Hote to Buyer

Response Valid Until | m/diyy homm a Fg
Attachments None =
4 Contract Terms

4 Variables (@)

Provide values for the listed variables. The values you enter are automatically populated in the contract terms.

View w Format w Freeze Wrap View | All variables ~

Name Description Value Clauses
Mo data to display.

vd-devl.fa.us? oraclecloud.com/fscmUl/faces/FuseWelcome?_afrl oop=3 frii frMFM frvIFR=96&_afrMFC _afri ¢_afrMFO=0%

Step Action

16. Click in the Note to Buyer field. (Optional).

Date Created: 6/24/2021 5:54:00 PM Page 11




Job Aid

ORACLE
USER PRODUCTIVITY KIT

& PWCMobius

Title Bridge Repair

Creste Response (Response 4010): o [ STy Ry - ]

Last Saved 6/17/21 1:41 AM
Time Zone Eastern Standard Time

Close Date  6/24/21 1:18 AM

Time Remaining & Days 23 Hours

General

Supplier A& M Concrete Corporation Response Type (@ Primary

Supplier Site STERLING-42685 Alternate

Hote to Buyer | Tes|

Solicitation Currency USD

Response Currency USD

Price Precision 2 Decimals Maximum

Response Valid Until | m/diy homm a

Attachments None =f=

4 Contract Terms

4 Variables (3)

Provide values for the listed variables. The values you enter are automatically populated in the contract terms.

View | Allvariables ~

Name Description Value Clauses

View w Format w Freeze Wrap

No data to display.

Step

Action

17.

Enter the desired information into the Note to Buyer field. Example - "Test". (Optional)

& PWCVobius m o ® .

| JONO)

Overvie Lines Review

Create Responso (Rospenso 4010): | ETARTESe e - Y N I

Last Saved 6/17/21 1:41 AM
Time Zone Eastern Standard Time

Title  Bridge Repair Close Date  6/24/21 1:18 AM

Time Remaining 6 Days 23 Hours

General

Supplier A& M Concrete Corporation Response Type (@) Primary

Supplier Site STERLING-42685 Alternate

Hote to Buyer | Test

Solicitation Currency USD

Response Currency USD

Price Precision 2 Decimals Maximum

Response Valid Until | m/diyy homm a

Attachments None =

4 Contract Terms

4 Variables (@)

Provide values for the listed variables. The values you enter are automatically populated in the contract terms.

View | Allvariables ~

Name Description Value Clauses

View w Format w Freeze Wrap

No data to display.

‘epvd-devl.fa.us2.oraclecloud.com/fscmUl/faces/FuseWelcome?_afrl oop

Page 12
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OoRrACLE’

USER PRODUCTIVITY KIT

Job Aid

Step Action
18. Click the Add (+) icon to add attachments.
Attachments
view w o= 3
Type * File Name or URL Description Attached By Attached De
No file selected. ‘ | Brian Grover BM7I21 1:414
‘
Rows Selected 1 Columns Hidden 1
Step Action
19. Click the Browse button.

Browse__.

Date Created: 6/24/2021 5:54:00 PM
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Job Aid ORACLE'
USER PRODUCTIVITY KIT

This PC > Desktop

older

Attached By Attached De

Brian Grover 6/M17i21 1:41 4

>

Step Action

20. Select the desired file.

This PC > Desktop

older

Music

B Pictures

Attached By Attached De
B TablessQL M Text Docum
Brian Grover 6117121 1:414

No file selected. >

Page 14 Date Created: 6/24/2021 5:54:00 PM




OoRrACLE’
USER PRODUCTIVITY KIT

Job Aid

Step Action

21. Click the Open button.

Attachments

Acions v View v o=

Type * File Name or URL Title

Description

Tables SQL tdt Tables SQL.xt

<
Rows Selected 1 Columns Hidden 1

Attached By

Brian Grover

Attached De

6M7i21 1:41

Step Action

22. Click on the OK button.
OK

Date Created: 6/24/2021 5:54:00 PM
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Job Aid

ORACLE
USER PRODUCTIVITY KIT

n v (@

BG

L JONO)

& PWCMobius

Creste Response (Response 4010): [ TRy Ry - ]

Title Bridge Repair

Time Remaining & Days 23 Hours

General

Supplier A& M Concrete Corporation

Supplier Site STERLING-42685
Solicitation Currency USD
Response Currency USD

Price Precision 2 Decimals Maximum

4 Contract Terms

4 Variables (3)

Last Saved 6/17/21 1:41 AM
Time Zone Eastern Standard Time

Close Date  6/24/21 1:18 AM

Response Type (@ Primary

Alternate

Test

Hote to Buyer

Attachments Tables SOL.bxt o= 3

Provide values for the listed variables. The values you enter are automatically populated in the contract terms.

View w Format w Freeze Wrap View
Name Description Value Clauses
No data to display.
Step Action
23. Click the Next button.
& PWCMobius m v ® e

0X - JO)

Owenvie Lines Review

Croste Responso (Rospenso 4010: [ ETAETEc e o o I

Currency = US Daollar

Time Remaining & Days 23 Hours

Actions w View v Format v Freeze

Last Saved 6/17/21 1:42 AM
Time Zone Eastern Standard Time

Close Date  6/24/21 1:18 AM

Wrap
* Alternate Create Response
Line Description Line Category Name Response Price PONSe oM Line Amou
Descripti Alternate Quantity
scription
1 Bridge Repair + 912.0000 Const. S
< >

Columns Hidden 7

Grand Totals

All response lines except alternate lines are included
Response Amount  0.00

/1.fa.us2 oraclecloud

Page 16
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ORACLE’ Job Aid
USER PRODUCTIVITY KIT

Step Action

24, Click in the Response Price field.

G PWCVObIUS SR EEE
Owenvie Lines Review
Crests Responsa (Responss 4010 [ I ey P ey )
Last Saved 6/17/21 1:42 AM
Currency = US Dollar Time Zone Eastern Standard Time
Time Remaining 6 Days 23 Hours Close Date  B24/21 1:18 Al
Acfions v View v Formalw & o Freeze Iy Detach Wrap
* Alternate Creat R
Line Description Line Alt::;::te Category Name Resp Price eSPOnse om Line Amot
Description Example format:
70,7
1 Bridge Repair L 912.0000 Const.
< >
Rows Selected 1 Columns Hidden 7
Grand Totals
All response lines except alternate lines are included
Response Amount  0.00
Step Action
- - - - - - " "
25. Enter the desired information into the Response Price field. Example - "50000".

Date Created: 6/24/2021 5:54:00 PM Page 17




Job Aid ORACLE"

USER PRODUCTIVITY KIT

& PWCMobius ® v ® .

0X : JO)

Owenvie Lines Review
Crosto Responsa (Rosponse 4010 . | TR Ik 2

Ci =US Dall Last Saved 6/17/21 1:42 AM
e o Time Zone Eastern Standard Time

Time Remaining 6 Days 23 Hours Close Date  £24/21 7:18 Al
Acfions v View v Formatw 4 o Freeze Wrap

* Alternate Create Response

Line Description Line Alternate Category Name Resp Price po uom Line Amot
Description Example format:

0.3
1 Bridge Repair L 912.0000 Const. 50000
< >

Rows Selected 1 Columns Hidden 7

Grand Totals

All response lines except alternate lines are included
Response Amount  0.00

Step Action

26. Click the Next button.

& PWCVoDbius m P ® .

OJOX -/

Ovenvie Lines Review
Reviow Responso: Responso 4010 [ I ey e ey - | N I I

Currency = US Dollar Last Saved 6/17/21 1:42 AM
oy = Time Zone Eastern Standard Time
Title Bridge Repair Close Date  6/24/21 1:18 Al

Time Remaining 6 Days 23 Hours

Overview  Lines

General
Supplier A& M Concrete Corporation Response Type Primary
Supplier Site  STERLING-42685 Reference Number
Solicitation Currency USD Note to Buyer  Test

Response Currency USD
Price Precision 2 Decimals Maximum Attachments Tables SQL.tt

Response Valid Until

4 Contract Terms

4 Variables (®

Provide values forthe listed variables. The values you enter are automatically populated in the contract terms.

View w Format w Freeze Wrap View | Allvariables ~

Name Description Value Clauses

Mo data to display.

Page 18 Date Created: 6/24/2021 5:54:00 PM




ORACLE

USER PRODUCTIVITY KIT

Job Aid

Step

Action

27.

Click the Save drop down arrow.

& PWCNobius &

OJOX -/

Overvie Lines Review
Review Response: Response 4010 [ I TR I Y

Currency = US Dollar

Title  Bridge Repair Close Date  6/24/21 1:18 AM

Time Remaining 6 Days 23 Hours

Overview  Lines

General
supplier A& M Concrete Corporation Response Type  Primary
Supplier Site  STERLING-42685 Reference Humber
Solicitation Currency USD Note to Buyer  Test

Response Currency USD

Price Precision 2 Decimals Maximum Attachments Tables SQL.txt

Response Valid Until

4 Contract Terms

4 Variables

Provide values for the listed variables. The values you enter are automatically populated in the contract terms.

View w Format » Freeze Wrap View | All variables ~

Name Description Value

Mo data to display.

Save and Close

™ [9 BG

Submit | Cancel

1:42 AM

T dard Time

Clauses

Step

Action

28.

Click the Save and Close option.
Save and Close

Date Created: 6/24/2021 5:54:00 PM
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Job Aid ORACLE’
USER PRODUCTIVITY KIT

O PWCMODIUS 5 F P e
Request for Qualification: 70043-21 | messages | create Response | actions v |

Gurrency = US Dollar Time Zone Eastern Standard Time
« Confirmation x

Title Bridge Repair Open Date 6M17/21 1:33 AM

Status  Active (Locked) Close Date  6/24/21 1:18 AM

Your changes were saved

Time Remaining 6 Days 23 Hours

=
Table of Contents Cover Page
Cover Page
oo REQUEST FOR
Contract Terms QUALIFICATION
Bridge
Repair

E| PUBLISHED DATE:6/17/21 1:33 AM
DUE DATE:6/24/21 1:18 AM
TIME ZONE: EASTERN TIME

vd-dev.fa.us2.oraclecloud.com/fscmUl/faces/FuseWelcome?_afrLoop= frMFC: frVIFC| frMFM=082_afrMFR=0) frMFG=08L_afrM _afrMFO=0%

Step Action

29, Click the OK button.
OK

& PWCMobius I

Request for Qualification: 70043-21 [ essages | create Response | actions + [ oone |

Currency = US Dollar Time Zone Eastern Standard Time
Title Bridge Repair Open Date 6M17/21 1:33 AM
Status  Active (Locked) Close Date  6/24/21 1:18 AM

Time Remaining 6 Days 23 Hours

=
Table of Contents Cover Page
Cover Page
oo REQUEST FOR
Contract Terms QUALIFICATION
Bridge
Repair

E| PUBLISHED DATE:6/17/21 1:33 AM
DUE DATE:6/24/21 1:18 AM
TIME ZONE: EASTERN TIME

vd-dev1.fa.us2.oraclecloud.com/fscmUl/faces/FuseWelcome?_afrLoop= il frvi {1 8_afriv ,_afrMFO=0&

Page 20 Date Created: 6/24/2021 5:54:00 PM




ORACLE
USER PRODUCTIVITY KIT

Job Aid

Step Action

30. Click on the Done button.

& PWCMOoDbius

Active Solicitations

4 Search

** Solicitation Close By | m/diyy e

Search Results

Actions ¥ View w Format w Freeze  [n| Detach

Wrap
Solicitation  Title Solicitation
Type
70043-21 Bridge Repair Request for Qu.
<

Columns Hidden 4

-devl .fa.us2 oraclecloud.com/fscmUl/faces/FuseWelcome?_afrl oop=3463..H

n v @

BG «

Time Zone Eastern Standard Time

Manage Watchlist | Saved Search

** Invitation Received
Response Submitted
Solicitation Open Since

I

** Atleastone is required

Accept Terms | Acknowledge Participation ‘ | Create Response ‘

Time Your Will Unread Vi

. Close Date Do s .
Remaining F PI
6 Days 23 Hours  6/24/21 1:18 AW 1 0 [F4
>

8&_afrMFC=88_afrMFC|=08_afrMFM=08_afrMFR=968_afrMFG=08_afrMF: afrMFO=0#

Step Action

31. Click the Done button.

Date Created: 6/24/2021 5:54:00 PM
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Job Aid

ORACLE
USER PRODUCTIVITY KIT

& PWCMobius

Supplier Portal

Tasks
Orders

» Manage Orders
» Manage Schedules

» Acknowledge Schedules in Spreadshest
Agreements

# Manage Agreements
Shipments

# Manage Shipments
» Create ASN

» Create ASBN

» Upload ASN or ASBN
» View Receipts

= View Returns
Contracts and Deliverables

« Manage Contracts

# Manage Deliverables
Consigned Inventory

» Review Consumption Advices
» Review Consigned Inventory

» Review Consigned Inventory Transactions

Requiring Attention

M Hegotiation Responses 1 Negotiations Closing Soon

Recent Activity
Last 30 Days

Negotiation invitations 1
MNegofiation responses awarded or rejected

Orders changed or canceled

wWow W

Orders opened

]

14 @ BG

Step

Action

32.

Scroll down the page.

Supplier Portal

» L mon
» Create ASBN
» Upload ASN or ASBN
* View Receipts
» View Retumns

Contracts and Deliverables

» Manage Contracts

= Manage Deliverables
Consigned Inventory

+ Review Consumption Advices

+ Review Consigned Inventory

+ Review Consigned Inventory Transactions
Invoices and Payments

» Create Invoice
s Create Invoice Without PO
 View Invoices

= View Payments
Solicitations

» View Active Solicitations

# Manage Responses

Qualifications

# IManage Questionnaires

= View Qualifications

Company Profile

evl.fa.us2 oraclecloud.c

. 4

M HNegotiation Responses 1 Negoliations Closing Soon

Recent Activity
Last 30 Days

hNegofiation invitations 1
MNegofiation responses awarded or rejected 3
Orders changed or canceled 3

3

Orders opened

Transaction Reports
Last 30 Days

PO Purchase Amount o usp

Supplier News

es/FuseWelcome?_afrloop:

¢_afrMFO=0#

Page 22
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ORACLE
USER PRODUCTIVITY KIT

Job Aid

Step Action

33. Click the Manage Responses link.

Manage Responses

& PWCNMobius

Manage Responses

Search Results

Revising a draft response automatically locks it

Columns Hidden 8

wd-devl.fa.us2.oraclecloud.com/fscmUl/faces/FuseWelcome?_afrLoop:

Line Description |

Actions v View v Format w Freeze iy} Detach Wrap | Accept Terms
Response ;tatus Title ?:;::“mi“"
4003 Active 70035-21 RFQualification Test Request for Qu..
4010 Draf) 7004321 Bridge Repair Request for Q..
4007 Active 70037-21 Test Information Request for Info
4004 Active 70036-21 Test Qualification Request for Qu
2002 Active 70021-21 RFP1 Requestior Pro...

Time Zone Eastern Standard Time

4 Search Manage Watchlist| Saved Search ‘Ac‘twe or Draft Responses

** At least one is required

Time
Remaining

1 Day 19 Hours
6 Days 23 Hours
0 Seconds

0 Seconds

Mot applicable

Unread
Messages

0

0

Monitor

MFO=0#

Step Action

34. Click in the Response field.
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Manage Responses

Time Zone Eastern Standard Time

Manage Watchlist | Saved Search ‘ Active or Draft Responses ~ ‘

** At least one is required

** Solicitation Title : ** Response Status | Active or draft
** solicitation I: Line Description | |

4 Search

Search Results

Revising a draft response automatically locks it

Actions w View w Format » Freeze Wrap Accept Terms
Response ;tatrus icitati icitation Title %?pe -Igie“::aining Meu.fs";;i: Monitor
4003 Active 70035-21 RFQualification Test Request for Qu_ 1 Day 19 Hours 0
4010 Drafte) 7004321 Bridge Repair RequestforQu... 6 Days 23 Hours 0
4007 Active 70037-21 Test Information Requestforinfo... 0 Seconds 0
4004 Active 70036-21 Test Qualification Request for Qu_ 0 Seconds 0
2002 Active 70021-21 RFP1 Requestfor Pro...  Not applicable 0

Columns Hidden 8

Step Action

35. Enter the desired information into the Response field. Example - "4010".

& PWCVobius m o ® .

Manage Responses M

Time Zone Eastern Standard Time

Manage Watchlist | Saved Search ‘ Active or Oraft Responses ~ ‘

** Atleastone is required

** Solicitation Title I: ** Response Status | Active or draft
** solicitation : Line Description | |
** Response | 4010|

4 Search

Search Results
Revising a draft response automatically locks it

Actions v View v Format v Wrap Accept Terms

Response Time Unread

Response Status Solicitation Title Remaining Messages Monitor
4003 Active 70035-21 RFQualification Test Request for Qu_. 1 Day 19 Hours 0
4010 Draft?) 7004321 Bridge Repair RequestforQu_. 6 Days 23 Hours 0
4007 Active 70037-21 TestInformation Requestforinfo... 0 Seconds 0
4004 Active 70036-21 Test Qualification Request for Qu_. 0 Seconds 0
2002 Active 70021-21 RFP1 Request for Pro.. Mot applicable 0

Columns Hidden 8
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Step Action

36. Click the Search button.

Search

& PWCVobius

Manage Responses

b Search

Search Results
Revising a draft response automatically locks it.

View w Format v

Freeze

Response P
Response Status Solicitation
4010 Draﬂﬁ 7004321

Columns Hidden 8

i Detach

Time Zone Eastern Standard Time

Manage Watchlist | Saved Search | Active or Oraft Responses ~ ‘

Wrap

Accept Terms | Revise

Solicitation Title Solicitation

Time

Unread Monitor
Type Remaining Messages
Bridge Repair Request for Qu.. 6 Days 23 Hours 0

Step Action

37.

Click the Actions button.

Actions =

Date Created: 6/24/2021 5:54:00 PM
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& PWCMobius

Manage Responses

b Search

Search Results

Revising a draft response automatically locks it

Mﬂrmm v Freeze iy Detach Wrap | Accept Terms
A e
ccept Terms p P icitation Title Solicitation
tatus Type
Revise
“"Cl T0043-21 Bridge Repair Request for Qu..
Unlock Draft
Delete Draft

® &G

Time Zone Eastern Standard Time

v

Manage Watchlist | Saved Search | Active or Draft Responses

Time Unread .
. Monitor

Remaining Messages

6 Days 23 Hours 0

Step

Action

38.

Click on the Unlock Draft list option.
Unlack Draft

& confirmation ®

The response 4010 was unlocked.

Page 26
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Step Action

39. Click on the OK button.
ok

& PWCMobius

Manage Responses

b Search

Search Results

Revising a draft response automatically locks it

Done

Time Zone Eastern Standard Time

Manage Watchlist | Saved Search | Active or Draft Responses ~ ‘

Columns Hidden 8

Actions ¥ View v Format w Freeze iy Detach Wrap | Accept Terms
Resp . Solicitation Time Unread .
Response Status Title Type Remaining Messages Monitor
4010 Draft T0043-21 Bridge Repair Request for Qu_ 6 Days 23 Hours 0

Step Action

40. Click the Revise button.

Revise

Date Created: 6/24/2021 5:54:00 PM
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L JONO)

Overvie Lines Review

Creste Response (Response 4010): o [ TRy Ry - [

Last Saved 6/17/21 1:44 AM
Time Zone Eastern Standard Time

Title Bridge Repair Close Date  6/24/21 1:18 AM

Time Remaining & Days 23 Hours

General

Supplier A& M Concrete Corporation Response Type (@ Primary

Supplier Site STERLING-42685 Alternate

Solicitation Currency USD
Response Currency USD

Price Precision 2 Decimals Maximum Hote to Buyer | Test

Response Valid Until | m/dhy

Attachments Tables SOL.bxt o= 3

4 Contract Terms

4 Variables (3)

Provide values for the listed variables. The values you enter are automatically populated in the contract terms.

View w Format w Freeze Wrap View | Allvariables

Name Description Value Clauses

No data to display.

L_afrMFC=88_afrMFCI=08L_afrMFM=08_afrMFR: _afrMFG=08._afrMFS: ifMFO=0%

Step Action

41, Click the Next button.

& PWCVobius m v ® .

0X - JO)

Owenvie Lines Review

Create Responso (Rosponso 4010: [ ETARTEEc e oy o N I

Last Saved 6/17/21 1:44 AM

Currency = US Dollar Time Zone Eastern Standard Time

Time Remaining & Days 23 Hours Close Date  B/24/21 118 All

Actions w View w Format w Freeze Detach Wrap
* Alternate Create Response
Line Description Line Category Name Response Price PONSe - ;om Line Amou
. Alternate Quantity
Description
1 Bridge Repair + 912.0000 Const. 50,000.00 50,000
< >

Columns Hidden 7

Grand Totals

All response lines except alternate lines are included
Response Amount  50,000.00

frvIFO=0%
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Step Action

42. Click in the Response Price field.

& PWCMobius m v ® .

0X - JO)

Overvie Lines Review

Create Responso (Rosponso 4010: . [ ETTARTE e oy o N I

Last Saved 6/17/21 1:44 AM

Currency = US Dollar Time Zone Eastern Standard Time

Time Remaining & Days 23 Hours Close Date  B/24/21 118 All

Actions w View v Formatw = Freeze iy Detach = & < Wrap

* Alternate Create Response

Line Description Line Category Name P Price po! Line Amou
Description Alternate
P! Example format:
0.

1 Bridge Repair + 912.0000 Const.. 50.000.00 50,000
< >

Rows Selected 1 Columns Hidden 7

Grand Totals

All response lines except alternate lines are included
Response Amount  50,000.00

Step Action

43. Enter the desired information into the Response Price field. Example "60000".
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& PWCMobius ® v ® .

0X : JO)

Owenvie Lines Review
Crosto Responsa (Rosponse 4010 . | TR Ik 2

Ci =US Dall Last Saved 6/17/21 1:44 AM
e o Time Zone Eastern Standard Time

Time Remaining 6 Days 23 Hours Close Date 524121 1:18 Al
Acfions v View v Formatw 4 o Freeze Iy Detach Wrap

* Alternate Create Response
Line Description Line Alternate Category Name Resp Price po uom Line Amot

Description Example format:

0.3

1 Bridge Repair L 912.0000 Const. B0000| | 50,000
< >

Rows Selected 1 Columns Hidden 7

Grand Totals

All response lines except alternate lines are included
Response Amount  50,000.00

Step

Action

44,

Click on the Next button.

& PWCVobius mF ® .

OJOX -/

Ovenvie Lines Review

Reviw Rosponso: Respenso 4010 ¢ [ ETRETEec e oy - I

Currency = US Dollar Last Saved 6/17/21 1:44 AM
oy = Time Zone Eastern Standard Time
Title Bridge Repair Close Date  6/24/21 1:18 Al

Time Remaining 6 Days 23 Hours

Overview  Lines

General
Supplier A& M Concrete Corporation Response Type Primary
Supplier Site  STERLING-42685 Reference Number
Solicitation Currency USD Note to Buyer  Test

Response Currency USD
Price Precision 2 Decimals Maximum Attachments Tables SQL.tt

Response Valid Until

4 Contract Terms

4 Variables (®

Provide values forthe listed variables. The values you enter are automatically populated in the contract terms.

View w Format w Freeze Wrap View | Allvariables

Name Description

Value Clauses
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Step Action

45, Click on the Submit button.

& PWCMobius m v ® .

Manage Responses M

Time Zone Eastern Standard Time

4 Search & Confirmation X i Search ‘Al:tiue or Draft Responses v‘
** Atleastone is required

** Solicitation Title Active or draft v
=* Solicitation |
** Response 4010

The response 4010 to solicitation 70043-21 was submitted.

Search Results

Revising a draft response automatically locks it

Actions v View v Format w Freeze | Detach Wrap | Accept Terms
Response Response Solicitation Solicitation Title solicitation Time . Unread Monitor
Status Type Remaining Messages
4010 Active 70043-21 Bridge Repair Request for Qu_. 6 Days 23 Hours 0

Columns Hidden 8

Step Action

46. Click on the OK button.
DK
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& PWCMobius

Manage Responses

4 Search

** Response 4010

Search Results

Revising a draft response automatically locks it

Actions w View w Format » Freeze Wrap Accept Terms
Resp . Solicitation
Response Status Title Type
4010 Active 70043-21 Bridge Repair Request for Qu_

Columns Hidden 8

Time Zone Eastern Standard Time

Manage Watchlist | Saved Search ‘ Active or Draft Responses ~ ‘

** At least one is required

** Response Status | Active or draft

Line Description | |

Time Unread .
. Monitor

Remaining Messages

6 Days 23 Hours 0

_aftMFG=08L_aftMFS:

ifMFO=0%

Step

Action

47.

Click on the Done button.

"PWCNVGOHILS

Supplier Portal

Tasks

Orders

Requiring Attention
» Manage Orders

» Manage Schedules

» Acknowledge Schedules in Spreadshest
Agreements

» Manage Agreements
Shipments

# Manage Shipments
» Create ASN

» Create ASBN

» Upload ASN or ASBN
» View Receipts

» View Returns M Negofiations Closing Soon

Contracts and Deliverables
= Manage Contracts Recent Activity

« Manage Deliverables Last30 Days

E| Megotiation responses awarded or rejected
Consigned Inventory

Orders changed or canceled
» Review Consumption Advices Orders opened
» Review Consigned Inventory

» Review Consigned Inventory Transactions
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Step

Action

48.

End of Procedure.
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